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simpler with the Set-Up Wizard.



Welcome to AccuRIP. Whether coming from another RIP or using a RIP for the first time, you will appreciate
the ease of use and quality you get from AccuRIP. We know you’re frustrated with other RIP solutions that
require too much attention and fail to deliver the results in a timely manner. Switch to AccuRIP today! 

AccuRIP is simple to install and configure and even easier to use. 

For over 25 years Freehand Graphics has been screen-printing, color separating, software developing and
educating screen printers. When our users asked us to put our experience into a screen-print specific RIP
we took on the challenge and AccuRIP is the result. Built as a “core” system driver once installed AccuRIP
is a PRINTER choice listed in the Print Window of all of your applications. AccuRIP is not like other RIP 
programs. It was designed and programmed to handle one specific and important task and to do it extremely
well.  Have a question or need some help - support is ALWAYS FREE!

VERSIONS & SUPPORTED DEVICES:

AccuRIP SF (Small Format)

AccuRIP Desktop Version
AccuRIP EX Version

Created by Screen Printers for Screen Printers

With 3 AccuRIP versions available AccuRIP supports numerous Epson Inkjet printers for the hobbyist
with an Artsian 50 to a business using the popular 1400 or a user of a wide format printer such as 
the 7900. 

For a current list of the various supported models (the list updates as drivers are added) please visit our
website: www.softwareforscreenprinters.com/accurip

AccuRIP works in the background ready to deliver films made with your shop’s parameters. Just Hit
PRINT and AccuRIP is called into action. It’s so easy - you just might forget about the technology behind
your films!

AccuRIP Software Manual

AccuRIP is a “core system” service which means it is ready when you are. Just select PRINT! No need to launch 
the program - it is available as a driver in ALL of your applications.
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With this new release users have an expansive Droplet Weight (ink density) control ability. Going from 3

droplet weight settings per resolution to 15 you have the ability to dial in on the precise setting to
achieve the needed density while gaining even greater control over the consumption of your ink. Users of
AccuRIP’s exclusive All Black Ink System further expand the control under the “Ink Coverage” option which
provides Less, Standard and More droplet weight settings (providing a total of 45 options). Greater control
through easy clicks of the mouse makes this new feature an extremely valuable one for our global user
base. Enjoy!  For instructions see page 8.
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AccuRIP SUPPORT is FREE: Reach a technician by submitting a request for support through our 
enhanced RAPID RESPONSE SYSTEM (RRS): www.softwareforscreenprinterstech.com
Help us help you by including details about your issue so the best qualified technician for your issue can get
you your resolve efficiently and quickly. Incomplete info may slow down your resolve.
Support can include email, phone and VNC (Virtual Network Connections). Free support is available to users
with Internet access only on the computer hosting AccuRIP Software on the current shipping version. 

Technicians are on hand from 9:30 am EST - 5:30 pm PST  Monday - Friday.

Don’t Miss It: 24/7 access to valuable tech info and videos are online!
www.softwareforscreenprinterstech.com

Advisory Pop-Up Windows!

Droplet Weight Feature with up to 45 Options Per Resolution Setting!

Free Tech Support and Info

AccuRIP set-up is even easier with pop-up windows in
the software.  An easy to understand explanation of a 
feature is at hand as you perform the set-up of AccuRIP.
Simply move your mouse over a selection.
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NO WATERMARK on your films!  Go to press while you test AccuRIP!

Freehand Graphics wants you to be as confident with your purchase of AccuRIP as you have been with all other
Freehand Graphics software. That’s why AccuRIP has a 14-day, fully-functional trial. Begin making money
with AccuRIP from day one of your trial!

STEP 1
Download the AccuRIP Trial available at www.softwareforscreenprinters.com

STEP 2
Run the installer for AccuRIP.  This manual explains the simple set-up process (see page 5).

IMPORTANT Note: After registration you will see on-screen a $0 shopping cart receipt - close the window
and the AccuRIP Setup Wizard will begin. 

FREE Trial Information

AccuRIP Software Manual

Because we know you’ll love it... PURCHASE OPTIONS

There are several easy options for purchasing AccuRIP Software at any time during your trial period or after
the trial has expired.

Option 1 (Valued Resellers):
We encourage you to contact the Valued Reseller that introduced you to AccuRIP.  Your Reseller will be happy
to handle your purchase for you and get you working with the full program as quickly as the same day.

Option 2 (Freehand Graphics):
• From within AccuRIP go to the “Purchase Menu” and purchase securely through E-Sellerate. You will be 

instantly and automatically activated!
• Purchase online http://www.softwareforscreenprinters.com/store
• Contact Freehand Graphics at 631-744-4330 / 9 am to 6 pm EST / Mon - Fri / USA and a sales 

professional will handle your order. 

www.softwareforscreenprinters.com (main web site)
www.softwareforscreenprinterstech.com (request support / view knowledgebase and videos)
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Run the Installer. The AccuRIP Set-Up Wizard will appear (see picture below). 

First Time Users will enjoy AccuRIP’s Set-Up Wizard designed to make the already simple,
one-time set-up process even easier and faster!

The Wizard will..

• walk you through the setup and connection of AccuRIP.
• locate Locally connected as well as TCP (Ethernet printers).
• build drivers and print a test page.

Once completed all the user needs to do is start using AccuRIP by simply selecting the "AccuRIP to Epson"
print driver (built for your Epson model) from your favorite applications print window.

Fine tune your results using the easy setup feature within AccuRIP (File Menu>Setup).

Step 1: Installation with Set-Up Wizard

AccuRIP Software Manual Page 5



The Set-Up Wizard completed the connection process and a TEST PAGE was made. Review your TEST
PAGE (film output). You can easily fine tune the results by choosing “Set-Up” from within AccuRIP.  For 
example, you can adjust the ink droplet weight to lighten or darken your results or adjust the resolution for
the best results. 

The Set-Up Menu is located:  File Menu>Setup. 

AccuRIP offers a simple 3 tab set-up with just a few questions. The 3 Tabs are shown and described on
the following pages. 

Step 2: After the Wizard

AccuRIP Software Manual Page 6



Tab 1 What printer do you have?

(a) PRINTER
Locate then select your printer model from the convenient pop-down list of AccuRIP supported printers.

(b) MEDIA
Select Roll or Sheet Size and set the proper size. AccuRIP automatically sets the page size based on your
document size in the application you are working in. Even though AccuRIP has this auto feature it is 
important to set the proper media size so you can take advantage of AccuRIP’s N-UP feature (ganging
up/nesting). N-UP printing is discussed further in the Special Features section of this manual Page 13
PLUS a PDF is available which can be located in your Applications/Program Files Folder/Main Application
Folder in the AccuRIP folder. VIDEO: http://www.softwareforscreenprinterstech.com/video-cafe
Mac Hard Drive>Main Application Folder>AccuRIP>App Notes
Windows: C:/Program Files>Fawkes Engineering>AccuRIP

(c) INK SET-UP
Unchecked (by default) - AccuRIP will draw ink from the Photo Black Ink Cartridge.
Checked - is for users of the All Black Ink Cartridge-based bulk system (aka. Black Max, Jet Black). 
AccuRIP reads the cartridge chips and instructs the inkjet to print (spray ink) from ALL of the ink cartridges

AccuRIP Software Manual Section: What printer do you have?Page 7

Hot Tips:
USB cables should be 6 feet long
or shorter to prevent data inter-
ruption/loss that could 
prevent files from printing. Note:
USB cable technology is not 
designed for long distance data
transport of postscript data or of
large files.

Your Epson printer should be
connected directly to the host
computer (where AccuRIP is in-
stalled). Do not use HUBS. It can
interrupt data flow causing fatal
errors.

AccuRIP can easily be shared
across your Local Area Network
(LAN). A Serial Number can be
used on one computer at a time.
The User can transfer the Serial
Number to a different computer
if desired. See 
Sharing Videos online.

More details on all topics are in
the web site Knowledgebase.

http://www.softwareforscreenprinterstech.com/knowledgebase



which now have our formulated black dye. When using the All Black option make sure all cartridges are
selected otherwise their will be an uneven draining of cartridges. Leaving cartridges unused (idle) may 
result in clogged inkjet heads and uneven draining - a main reason the All Black Ink system was 
developed in the first place!

Turning ON Multi-black displays all the ink cartridges in your printer and sets
coverage to “standard ink”. By default Ink Coverage is set to STANDARD.
Standard lays down 2 droplets, one directly on top of the other. This gives
most screen printers the density and accuracy needed for proper film mak-
ing. LESS delivers one ink droplet per space and MORE delivers 3 droplets
per space (all within a single head pass).

All Black Ink is an exclusive feature of AccuRIP and a high-production benefit designed to keep your 
device working as it was intended - with all cartridges in use regularly. For supported devices and info
please visit www.allblackbulkink.com

PLUS: Users of printer models NOT supported by the All Black Ink system can use the multi-black feature
with quality bulking systems. When Freehand manufactured All Black Ink supplies (available through sanctioned

Resellers of Freehand) are installed the multi-black option will be available.

(c) PRINTER SETUP
- PRINT RESOLUTION
Choose Print Resolution from the pop-down menu. This feature controls the print resolution of your printer.
Higher resolutions sometimes result in darker and more detailed prints but will result in slower printing
time. Always try to get the best results you can using 720 x 720 or 1440 x 720 before raising the 
resolution.  For your purposes dye will perform better than pigment (UltraChrome K3).

- DROPLET WEIGHT
Next select droplet weight (ranges from 1 lightest to 15 darkest ). The default is set to 6 which is a good
starting point to determine what your needs are based on your brand of film. Droplet weight controls the
flow of ink from the print head and has the greatest effect on a film’s density. Depending on your ink and
film combination you may have to increase or decrease this setting. For very thick films that require a lot
of ink you may need to use one of the heaviest settings. 

- BIDIRECTIONAL (High Speed Printing)
Bidirectional allows the inkjet head to spray ink in both directions (passes) and subsequently speeds file
output. By default an inkjet printer only sprays ink when the head is moving right to left. As long as the
film is not moving when the head is traveling left to right it is completely possible to spray ink accurately
on the return pass. Single pass is more accurate but test Bidirectional to determine if the results are good
for your purposes.

AccuRIP Software Manual Section: What printer do you have?Page 8
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Bidirectional works best with new printers and the ability of an inkjet to manage bidirectional diminishes
over time due to normal wear of the printer. If your printer starts to stage (move) film prematurely you may
experience blurred printing. If this happens simply turn off the bidirectional feature and have your printer
serviced. Default setting is off.

- Adjust Print Length
This feature allows users of large format style printers (Epson 4000 and higher) to precisely control the
length of prints over a long distance. The width of prints are unaffected. The registration from film to film
is exact but due to the stretching of media through the roller over a long length films can universally be
short by 1/64th of an inch (0.0396875cm) which doesn't matter to most screen printers because each
film registers. This has nothing to do with your RIP software it has everything to do with the thickness of
your film and your ink rollers. AccuRIP has addressed this need for precision industries (see below). 

So why has AccuRIP addressed this? 

Most screen printers don't have the need for exact dimensions, but (for example) those that need to
match films to "die cut" templates or have other specific dimension needs desire this control that AccuRIP
can deliver.

How do I use it?

1. Located in the AccuRIP program folder is a pdf file called "Adjust Print Test.pdf".
2. "Drag and Drop" this pdf file into the Queue window of AccuRIP and it will print. The test print 

requires 17"(43.18cm) of film. Measure the result.
3. Open the SETUP feature in AccuRIP and locate at the bottom of the first tab (What printer do you 

have?) the "Adjust Print Length" feature.
4. Positive numbers increase length while negative numbers decrease length.
5. Starting with number 19 reprint the test page until you have the desired result. Changes in 

increments of 10 make visual movements.

*It's advised to check your settings each time you change film rolls or brands as variations during 
manufacturing may effect your printers film feeding rate.
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Tab 2: Windows AccuRIP Setup (Local Connections) (left).  Windows  AccuRIP Setup (Network Connections) (right).
• convenient tab system   • easy to understand headings  • POP-UP Advisory Windows

Tab 2 How is your printer connected?

Connection Type: Select either Local or TCP (Network)  (example: Epson 1400, 1800 and 1900 select Local).

Local is for locally connected printers such as USB, LPT1 or Firewire. 
TCP (Ethernet) connected printers. Note: Firewire is only supported on Windows computers. 

Local connections: Windows computers will automatically pick up any printer connected via USB, LPT1
(Parallel) or Firewire. If you do not see a proper connection click “show all ports” (Windows only) and 
locate the proper printing port for your computer.

Network connections: (TCP/Ethernet) a “dummy” address of 127.0.0.1 will appear in the address field. Do
not attempt to connect using this false “dummy” address.

Address: Enter a proper IP Address for your printer or network print server. If you don’t know what it is 
contact your network administrator for help, access the network setup from the front control panel of your
Epson printer or use the “EpsonNet Config” software utility that can be downloaded from the Epson web site.
Instructional Videos are also available in our Video Café.

Port: 9100 is the default port for inkjet printers*. 

Test: Click this button to test that you have a good (passed) connection to your printer.

*EcoPro printers using the internal Ethernet card that has been converted from AT (Apple Talk) to Ethernet use Port 35. Don’t know how to do this?
Contact technical support: techsupport@accurip.net
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Tab 3 How would you like this screened?

Screen: There are many shapes to choose from when making a halftone screen. The default for AccuRIP is
ROUND. There is also DIAMOND, LINE, and ELLIPSE. Choose the shape you desire. Round and Ellipse are
the most commonly used shapes but ALL will work well.

Lock Screens: This simple feature is your greatest asset. Not only does it prevent user error when printing
films by universally overriding the setting in your various graphics applications to ensure proper film 
output, it also eliminates the need to address those settings in the graphics applications every time you
need to print your file or separations – saving you a tremendous amount of effort and time.

When you select your angle in AccuRIP (i.e. 22.5 degrees) your halftones will all be printed at the same
chosen angle - proven to be the cleanest printing method hands down. Lock screens assures that AccuRIP
controls the info provided to the printer and not your application(s). See page 12 for additional information
on the power and benefits of single angle printing (Flemenco). Want to use a Rosette? Simply TURN OFF
Lock Screens and the control of angle and frequency is managed by the Design Application and NOT 
AccuRIP. Be sure to address it in the graphic program’s PRINT WINDOW.

Angle: This sets the angle for the spot on your halftone screen. The default is 22.5 degrees and also
known to be the best screen angle for screen making when exposed to mesh screen properly stretched at

Tab 3 of the AccuRIP Set-UP shown at 
left (Windows users).
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a 90 degree angle and looks best when viewed after printing. There are a few other angles that work well
such as 61 degrees.

Frequency: Set your line screen value here. The default is 45 lpi which is a comfortable line screen for
most textile screen printers. Set this number to your desired line screen. In order to choose a proper mesh
count for a line screen multiply the lpi by 5 to establish the minimum mesh count to successfully capture
this line screen. Choose the next HIGHER screen mesh and never lower. Example, 45 line screen times 5
equals 225. Therefore you should use a 230 mesh or higher to eliminate exposure moiré.

Dot Gain Control: Detailed instructions are available on our web site Knowledgebase: Article ACC-0203 and 
this EXPERT LEVEL advanced feature is to be used ONLY by those with a Transmissive Densitometer that
require exact control over dot size as it relates to dot gain. This is not a procedure that can be handled by
eye. The most important factor is the use of good quality ink and film. With the use of better quality film
brands dot gain is dramatically reduced or eliminated. Poor quality films dot gain the most. Give yourself
the greatest chance for success. 

AccuRIP offers an Advanced Dot Gain control feature. Simply click the "Print Target" button. Be sure to
print on the film you use to make screens. Read the film or a print of the test film and apply those 
numbers to the proper fields to adjust the RIP for the inkjet printer. You can also Save and Load the cali-
brations as needed.

Understand that calibrations to film adjust the inkjet printer and not the printing press. For the most 
accurate calibrations it makes sense to calibrate the printing press so printing the Test Print on press and
measuring that result tells you how much dot gain is created by the "printing press" allowing you to make
the most accurate adjustments. Harder to do since there are changing variable on all presses. Most people
just calibrate the inkjet printer and do their best on press to control inks and pressure.

Single Angle Printing (Flemenco Printing): is historically the best method for printing halftones. 
Discovered in the late 1800s and patented by the Italian newspaper Flemenco users moved away from
single-angle printing ONLY because of registration problems of the cmyk printing presses during that time
period. Today the offset presses and screen print presses are far superior and have highly accurate 
registration processes. Screen printers will find a remarkable improvement in their halftone printing by
moving to single-angle printing (you’re welcome!) 

Not convinced?  During discussions many will say “it can’t be done” and when asked why they simply
have no good answer other than someone they think was knowledgeable told them that. Ask to see their
prints and find out just how hard they had to work at them. The conversation always turns to the "secret
angles" they have discovered and usually its that they simply line up the black and yellow screen which
improves clarity and reduces dot gain. I always say "great idea" but why stop there? You have improved
your print by only 50%. If you can line up two out of four colors and the world did not stop spinning then
why can't you line up all four? Usually followed by silence and a lot of brow ruffling. Now it sinks in and
they smile.
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A c c u R I P  O n  C a l l

AccuRIP is a “Core Service” which means it is always on call, ready and waiting. Think of it as “sleeping
until ready”.  Once you complete your set-up you do not need to open/launch AccuRIP to take advantage
of its service whenever you wish to print. 

Simply choose the AccuRIP Driver that will be available in all Print Menus. Go ahead and print as usual.

N - U P  P r i n t i n g

N-UP Printing (Auto Nesting) is a great automatic feature
usually reserved for larger format inkjets, but AccuRIP
brings this valuable ability to users of smaller format
inkjet devices too. 

Simply stated, N-UP Printing dramatically reduces usage
of consumables by automatically “ganging up/nesting”
smaller images so they make the most of your film size. 
A small image will NOT sit alone in the center of your
large, costly film. With N-UP Printing separation channels
will share space on your film. This feature not only saves
you in consumables but it saves output time.

PLUS: View our video...
http://www.softwareforscreenprinterstech.com/video-cafe

Note: AccuRIP adds its driver to your list
and does not remove or modify drivers as
other RIP solutions can. It is friendly with
your present setup.

AccuRIP Software Manual Exclusive / Special Features of AccuRIP

Screen Shot of the Adobe Illustrator Print Window

Original Art File

Film results with N-Up Printing



N-UP Printing 

HOW TO:
N-UP Printing is an “automatic” feature  activated when the page size (media size) of your graphic in 
any application is smaller than half the size of film selected in AccuRIP. To make the most of this feature 
simply make your page size (media size) large enough to accommodate your image, registration marks and
plate labeling. When AccuRIP sees that your page size is half the size of your film size it will 
automatically fit and organize as many images on a single film as possible.  AccuRIP applies division mathe-
matics. For more information specific to your graphics program refer to the supplied PDF 
documents in the AccuRIP program folder. 

Mac Hard Drive>Main Application Folder>AccuRIP>App Notes
Windows: C:/Program Files>Fawkes Engineering>AccuRIP
PLUS: View our video...
http://www.softwareforscreenprinterstech.com/video-cafe

AccuRIP Menus Explained

The AccuRIP Menus are easy to navigate and for the most part the user will not need to use the features
in the Menu.

About Menu (Mac)
Mac users only can access the “About” feature (under the AccuRIP Menu) to check their version and build
number. Handy for tech support and knowing when to update your software. Windows users can find the
same information under the “Help” Menu.

Hide AccuRIP (Mac)
Hides the AccuRIP window.

Quit AccuRIP (Mac)
Quits AccuRIP the application only. AccuRIP is always available as a ready to select driver in all of your 
applications. Quitting AccuRIP does not affect your ability to use AccuRIP anytime. No need to launch 
the application AccuRIP to use AccuRIP.  The print services are always ready in your graphics program’s
print window.  This is a great benefit of AccuRIP.

AccuRIP Software Manual Exclusive / Special Features of AccuRIP

Macintosh Menu Bar (shown in trial mode).
“Purchase” changes to “Transfer”

Windows Menu Bar (shown in purchased mode). Trial
users would see “Purchase” rather than “Activation”.
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Under the File Menu you will find: 
Setup • Halftone Test Print • Droplet Weight (Density) Test Print • Quit (Quit is available here for the WIndows version only)

Setup
Brings up the 3 Tab Setup Windows that we have discussed in length earlier in the manual. You can revisit
the Setup any time you wish to change your AccuRIP settings such as when you switch to a different 
supported inkjet model or to change your shops desired lpi (line screen) (frequency).

Halftone Test Print
As part of the AccuRIP setup we recommend you do a Test Print using our stock file to help you evaluate
the structure and quality of the halftones you chose in the setup. Test Print will deliver a single piece of
film with copy and graphics created specifically for your testing of AccuRIP. 

Droplet Weight (Density) Test Print **NEW ADVANCED FEATURE**
This feature allows you to see the effects of the 15 droplet weight settings when printing films using your
ink (dye/pigment) in your inkjet to your film brand.  Note: ink/film brands are important to your success
and your ability to better control costs associated with ink usage. Waterproof brands are recommended.  

HOW TO USE THIS NEW FEATURE:
Go to the File Menu>Setup.  Step 1: choose a resolution. Step 2: turn off bi-directional. Step 3: Use the 
default Droplet Weight (in a Droplet Weight Test Print the chosen droplet weight in the Setup window will
NOT have any effect on the test print). Step 4: Only users of an “All Black Ink system” should have the
multi-black feature checked on and ink coverage should be set to standard for the first test print. Raise or
lower ink coverage depending on the results of the test. Your goal is to use the least amount of ink while
still achieving the density you require to burn screens effectively. 

Quite AccuRIP (Windows)
Quits AccuRIP the application only. AccuRIP is always available as a ready to select driver in all of your 
applications. Quitting AccuRIP does not affect your ability to use AccuRIP anytime. Not needed to launch
AccuRIP to use AccuRIP is a great benefit of the program.

Under the Jobs Menu you will find: 
Refresh Job List • Pause Job Processing • Resume Job Processing • Cancel Job • Delete Job • Cancel
All Jobs

These are your controls for job queue or you can use the friendly icons in the Main AccuRIP Window! Roll
your mouse over the icons for a pop up description.

Trash Can/Recycle Can: 
Deletes selected files from the Job Queue.
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Green Square:
STOPS your job from printing.
The Jobs Menu also includes the option to Cancel All Jobs.

Double Green Bars: 
PAUSES the printing.

Green Arrow (triangle):
RESUMES printing. If the RIP is Paused you will see this displayed in the lower left corner of the AccuRIP
window. It will say "RipCore Paused". Click the "Resume" (Green Arrow) icon to turn printing back ON. The
display should say "RipCore Ready".

*AccuRIP can go into the “Paused” Mode any time a file is not fully printed. Causes can be from
the printer not being turned on to a broken Network connection to the printer.

Under the View Menu you will find: 
Job History • Job Details • Tool Bar

Here is where you can control what Menus you see in the AccuRIP Window.  All Menus are “tear away” so
you can configure your on screen appearance to suit your needs.  Job History and Details provides basic
job information about the files sent and processed with AccuRIP.  Tool Bar can be viewed or hidden by
checking or unchecking it under the View Menu. 

WINDOWS USERS:
Under the View Menu you will also find: 
Help • About

Help Menu (WINDOWS USERS ONLY): 
Windows uses will have access to a Help Menu.

About (WINDOWS USERS ONLY): 
In this location Windows users can access the “About” window to check their version and build number.
Handy for tech support and knowing when to update your software to the latest build of their purchased
version.

Note: About for Mac users is located under the AccuRIP Window.

Under the Purchase Menu you will find: 
Buy Online • Enter Serial Number 
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This Menu is ONLY displayed in the trial versions. Once the software is purchased the Menu changes to
ACTIVATION.

Purchase Menu: 
You can Purchase AccuRIP directly online. This provides for instant unlocking (just a few minutes). Your
purchases are “secured” through E-Sellerate. 

Transfer Menu: 
Visible in versions that have had a serial number entered.

Transfer Activation: (requires Internet connection) If you need to "move" AccuRIP to another computer 
you must first "de-activate" the serial number before re-installing. It is advised to wait 20 minutes after
de-activation before re-installing. This gives our security servers time to communicate and reopen access
to your serial number.

Don’t "remove or delete" the software from the original computer AccuRIP was installed. Removing or
deleting is not the same as de-activating. You MUST "de-activate" by doing a Transfer Activation before
moving and re-installing AccuRIP. 

AccuRIP is a "single install" license that allows you to "share" the driver with your entire network not 
"install" and activate it on multiple computers. * Too many failed attempts at multiple installations will 
result in a security lock out and the need for you to contact tech support at techsupport@accurip.net.
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The Job Queue, Job History and Job Details window are displayed together or may be torn apart to float
on their own.

1. Job Control Tools: 
Located at the top of the Job Queue window (may also be repositioned to the left side of the window by
dragging and drop. Use the Open file, Trash, Stop, Pause and Play icons to control jobs selected in the Job
Queue.

2. Job Queue: 
Displays the present file printing and all the separations related to that file as well as all jobs waiting to be
printed.

3. Job History: 
Click on any job previously printed to display Job Details. Mac and PC users can right click to reprocess
jobs. Jobs with green check marks indicate  the job has fully processed - printed. Jobs with an “X” failed
to process and may need investigation or possible reprinting from the application.

4. Job Details: 
Provides general information about the job (i.e. file name, Rip Time, etc.)
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5. Status and Data Bar: 
Located at the bottom of the Job Queue window, it displays all critical data about AccuRIP and its network.

Moving Windows:
The Job Queue, Job History and Job Details windows may be pulled apart (tear away / float). Click on the
window name and drag, then release the mouse over the desktop. To resize the window, click and drag
the lower right corner of the window.

To return the window to the Main Job Queue window click once on the Window Return icon 
located at the upper right corner of the window or click and drag the window name, releasing the mouse
over the Job Queue window.

Close the window by clicking on the “X” located at the upper right corner of the window.

Open a closed window by going to the “View Menu” and selecting the window.

Have a PDF, PS or EPS file and don’t have an application for these files?
Simply drag and drop the file into the Job Queue.
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Printing with AccuRIP

With AccuRIP installed and your AccuRIP to Epson Driver for your specific model successfully built you are
ready to output your graphics file/separations (solids, halftones, postscript data). The experience of work-
ing with AccuRIP is much like working with a laser printer. It is driver-based so there is no extra workflow
or special requirements. In short - it is the easiest means to quality output. AccuRIP is NOT a separation
software or engine. It allows you to output separations to an Epson inkjet which is a non-Postscript device.

Know your Graphics Applications Print Window and Features:
AccuRIP allows you to print directly from your graphics application (i.e. Adobe Illustrator, InDesign, Photoshop,

Corel DRAW, Photo Paint, Painter, Freehand, Flexi, Canvas and more). You will follow your usual file output procedures
in these graphics programs and simply choose your AccuRIP to Epson driver as your printer.

If you are not familiar with how to navigate your graphics program PRINT Window and print features when
outputting separations you should review your program manual.  AccuRIP takes over the task of file output
after you have made the proper selections in the Print Window of your design program (i.e. Illustrator,

DRAW, Photoshop, etc.) To help the end-user we have posted documentation and have created videos that can
be found online for the most common applications used by screen-printers such as Adobe Illustrator and
Corel DRAW.   Visit www.softwareforscreenprinterstech.com

Which graphics applications can you print from?
You can print from any Postscript-based design program (there are many). The most commonly used 
programs in the screen-print industry are Illustrator, Photoshop, DRAW, Photo Paint, Painter, Freehand, 
InDesign, QuarkXPress, Flexi, Canvas, etc. 

What are the typical selections in the Print Window that I will need to address?
To answer this question we have provided videos of Adobe Illustrator and Corel Draw in our Video Café 
located at www.softwareforscreenprinterstech.com. Programs vary and versions within programs also vary
so be sure to learn your Print Window well. But, anyone who has the task of printing files should already
have the understanding of how to print “separations” as opposed to printing a color composite to an Epson
using the standard Epson driver.

Note: since AccuRIP Software is called into play after the Print Window selections are made, unexpected
print results most often are related to file development or incorrect selections made in the Print Window.
The hardware should also be on, in good working order, directly connected to the computer that hosts 
AccuRIP, have a proper length USB cable(6 feet or less) (no hub), and all ink cartridges inserted and with
available ink. Printer errors or lights alerting you that your hardware has an issue need to be addressed
before outputting your file as separations to film.
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AccuRIP Serial Numbers

• My serial number is not unlocking the trial into a full purchased version. I am receiving an error.

- Purchasers: 
Make sure that you copy and paste the ENTIRE purchase code including the ACCU... into the Enter Serial
Number field (see below).

If you type it in be sure that it is in ALL CAPS.
It must contain the dashes - and there are
NO SPACES. 

When entering a serial number note that
there are no letter O’s only number zeros in
an AccuRIP Serial Number.

Unlock errors are: 
• user typing errors
• copy and paste errors (used just part of
the serial number)
• users attempt to use a serial number that
has already been activated on another 
computer.

The Error Message INVALID SERIAL NUMBER is a user input error and does not mean the Serial Number is
not correct.

There are proper means to transferring your AccuRIP Serial Number off of one computer to be used on 
a different computer. This is handled by the user under the AccuRIP Software’s TRANSFER Menu. 
Information on Transferring a Serial Number is documented on page 17.
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Contact Information

Freehand Graphics, Inc.
31 Ridgefield Drive
Shoreham, NY 11786 USA
www.softwareforscreenprinters.com
631-744-4330 PH
631-821-3670 FX

24/7 Access to Tech Info: 
24/7 access to valuable tech info and videos are online!
www.softwareforscreenprinterstech.comA valuable resource for 
AccuRIP software users as well as for general screen-printing information is our
KNOWLEDGEBASE and VideoCafé.

Rapid Response Tech Support: 
Submit a request for support through our RAPID RESPONSE SYSTEM. Provide details so
a technician can resolve your issue quickly.
www.softwareforscreenprinterstech.com

email:  tech@softwareforscreenprinterstech.com

© 2006-2011 Fawkes Engineering & Freehand Graphics, Inc.   All Rights Reserved.

Thank you for reading the manual and using AccuRIP Software. We appreciate your business.

AccuRIP™

www.softwareforscreenprinters.com


